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Overview 
The estimated time to complete this lab is 60 minutes. 

In this lab, you will complete the following tasks: 

1. Start with pre-loaded PBIX file 

2. Create a MANY to ONE relationship in Power BI Desktop 

3. Create Measures in Power BI Desktop 

4. Build a Report Page with Visual Types:  Card, Slicer, Matrix, Custom Visual, Bar Chart 

5. Add small multiples break-down to Bar Chart 

6. Add Conditional Formatting Icons to Matrix Visual  

7. Add Conditional Formatting to Card 

 

 

NOTE:  This lab has been created based on the sales activities of the fictitious Wi-Fi company called SureWi 

which has been provided by P3 Adaptive https://p3adaptive.com/.  The data is property of P3 Adaptive and 

has been shared with the purpose of demonstrating Excel and Power BI functionality with industry sample 

data.  Any use of this data must include this attribution to P3 Adaptive. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://p3adaptive.com/
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Exercise 1:  Start with a pre-loaded PBIX 
In this exercise, you will launch Power BI Desktop and open a PBIX file that has all the Data & Lookup 

tables loaded and the data model already partially built. 

Task 1: Launch Power BI Desktop 

In this task, you will launch Power BI Desktop and save the new PBIX file. 

1. Launch Power BI Desktop. 

 

2. If applicable, use the x in the upper right-hand corner to close the Welcome window. 

 

Task 2: Open the PBIX file 

In this task, you will navigate and open the starting PBIX file. 

3. From the ribbon at the top of the screen, select the File tab. Then, select Open report from the list 

to the left of the screen and choose Browse reports. 
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4. Navigate to the <CourseFolder>\MAIAD Attendee\Lab Materials\Lab 02B\ folder. 

5. Select the file MAIAD Lab 02B – Power BI Model – Start.pbix and choose Open. 

 

Task 3: Save the PBIX file 

In this task, you will save the file with a new file name. 

6. From the ribbon at the top of the screen, select the File tab. From the list to the left of the screen, 

select Save as.  

 

7. Save the file as MAIAD Lab 02B – Power BI Model – My Solution.pbix. 
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Exercise 2:  Create MANY to ONE 
relationships in Power BI Desktop 
In this exercise, you will create the relationships needed to complete the data model.  You will create 

relationships from the Quotes Data table to each of the Lookup tables in the data model. 

Task 1: Create relationship from Quotes to Customers 

In this task, you will create the relationship from the Quotes Data table to Customers Lookup table. 

8. On the left-side of the screen, within the navigation menu, there are three options: Report, Data, 

and Model. Select the Model view icon. This changes the display area from the default Report 

view to the Model view to show the data model diagram. 

 

9. While inside the Customers Lookup table, use your mouse wheel or the scrollbar on the right to 

navigate down to make the ID field visible.  

10. Select the CustID column from the Quotes table, then drag and drop the column to the ID 

column on the Customers table. This will create a relationship line between the two 

columns/tables. 

   

Note: When creating relationships, the name of the column is not important; however, the data type 

and values in the columns should match.  
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Task 2: Create relationship from Quotes to Dates 

In this task, you will create the relationship from the Quotes table to Dates table. 

11. Select the InquiryDate column from the Quotes Data table, then drag and drop to create the 

relationship line to the Date column on the Dates table. 

 

Task 3: Create relationship from Quotes to Offices 

In this task, you will create the relationship from the Quotes Data table to Offices Lookup table. 

12. Select the CountyID column from the Quotes table, then drag and drop to create the relationship 

line to the CountyID column from the Offices table. 

 

Note: By adopting the best practice of arranging the Lookup tables above the Data tables in the Model 

view, you will be able to visualize the filters from Lookup tables “flowing down through those 

relationship lines” to the Data tables – this will be very helpful when you learn how the DAX engine 

calculates measures. 
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Exercise 3:  Create Measures in Power BI 
Desktop 
In this exercise, you will create measures on the Quotes table and learn two different ways that new 

measures can be created in Power BI Desktop.   

Task 1: Create a New Measure from Data Pane 

In this task, you will create a New measure on the Quotes table using the ellipses from the Data pane. 

13. From the menu to the left of the screen, select the Report view icon. 

 

14. From the Data pane to the right of the screen, select the ellipses (…) to the right of the Quotes 

table. 

 

15. From the menu, select the New measure option. 
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Task 2: Create the Measure [Potential MRR] 

In this task, you will use the DAX function SUM() to create the business logic needed to calculate 

Monthly Recurring Revenue amount from the Quotes table. 

16. In the New measure formula bar, remove the default Measure = value. 

17. Enter the following DAX formula & then select the check mark to the left of the formula bar to 

commit:   

Potential MRR = SUM( Quotes[QuoteAmt] ) 

Note: As you type the DAX function SUM, you will see Intellisense with matching options, double-click 

to the select the SUM() function.  As you begin to type “Quotes”, you will also see Intellisense with 

matching Quote table and column names – double-click the field to select. 

 

Task 3: Format the Measure [Potential MRR] 

In this task, you will use the Measure Formatting Tools to format the Measure Potential MRR. 

18. Select the measure Potential MRR from the Quotes field, located in the Data pane to the right of 

the screen. 

 

Note: Measures can be identified in the Data pane by the Calculator icon. 
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19. Select the Measure tools tab from the ribbon at the top of the screen.  

20. Located in the Formatting section of the Measure tools menu at the top of the screen, select the 

drop-down for Format and change it to a Currency format type.  

 

21. While still in the Formatting section of the Measure tools menu at the top of the screen, change 

the decimal places from Auto to 0. 

 

Task 4: Create the Measure [Won vs Potential MRR] 

In this task, you will use the DAX function DIVIDE() to create the business logic needed to calculate the 

percentage of Potential Monthly Recurring Revenue that has been Won on Quotes table. For this 

measure, you will use the existing data model measure called MRR Won – Contracts from the 

Contracts Data table. 

22. Select the Quotes table from the Data pane to the right of the screen. 

23. Ensure that the Table tools tab is selected from the ribbon at the top of the screen, then select the 

New measure button from the menu.  
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24. In the New measure formula bar, enter the DAX formula & then select the check mark to 

commit:   

[Won vs Potential MRR] = DIVIDE([MRR Won - Contracts], [Potential MRR]) 

 

 

Note: When entering the DAX formula, and as you type the open square bracket ( [ ), you will notice 

intellisense displays a list of the available measures that have been created. 

Task 5: Format the Measure [Won vs Potential MRR] 

In this task, you will use the Measure Formatting Tools to format the Measure [Won vs Potential MRR]. 

25. Select the Measure tools tab from the ribbon at the top of the screen, then change the format of 

the measure to Percentage. 

26. Validate that the decimal places value is set to 2 and remove the comma, if selected. 
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Exercise 4:  Build a Report Page with 
Visuals:  Card, Slicer, Matrix, Custom 
Visual, and Bar Chart 
In this exercise, you will create a report page with a Card, Slicer, Matrix Custom visual, and Bar Chart. 

Note: If at any time you need to undo a step, you can always use the Undo button above File in the 

main menu.  

 

Task 1: Create a Card visual 

In this task, you will create a Card visual using measure Potential MRR. 

27. From the Data pane to the right of the screen, select the Potential MRR measure from the 

Quotes table and drag the measure to an empty design space on the report page. 

Note: Depending on the field type and the data type of the field, you will get a default visual once 

you drag and drop a new field onto the report page. Since we have a measure, by default we get a 

Clustered column chart visual – you can see the chart name by hovering over the icon on the 

Visualizations pane.  
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28. From the design space, select the Clustered column chart visual to make it active and then 

select the Card visual icon from the Visualization pane.   

 

Task 2: Resize the Card visual 

In this task, you will resize a Card visual. 

29. Select and drag the visual border to resize the Card visual. 

(You can also select the Format visual/Paint Brush icon from the Visualizations pane, select 

General and expand the Properties to change the Width and Height values located in the 

General Properties. 
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Task 3: Format the Card visual 

In this task, you will apply formatting to the Card visual – you will add Conditional Formatting to the 

Data label, apply a Background color, Callout value Label, and a Border. 

30. From the Format visual/Paint Brush icon properties, select Visual and then expand the Callout 

value properties. 

31.  Select the Fx symbol next to the Color property – this will apply a Conditional Formatting based 

on the Data label value. 
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32.  In the Color – Callout value window, change the Format style drop-down to Rules. 

33. Enter the Rule:  Is greater than or equal to Minimum Number and is less than or equal to 

90,000,000 Number.  Then, use the drop-down to apply the color Red. 

34. Select the +New Rule button. 

35. Enter the Rule:  Is greater than 90,000,000 Number and is less than or equal to Maximum 

Number.  Then use the drop down to apply the color Green. 

 

Tip: By removing the ending low & high range values in the rules, you will get a Minimum and 

Maximum range that adjusts dynamically. 

 

36. Select OK 
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37. From the Format visual/Paint Brush properties, select General and expand the Effects property.  

Set the Background toggle to On. 

 

38. Ensure that the Color is set to White.  Change the Transparency to be set to 0%. 

Note: You can also use the Fx icon to use Conditional Formatting for Background color. 
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39. From the Format visual/Paint Brush property in the Visualizations pane, under General, 

navigate down to the Visual border property and set the toggle to On. 

 

 

Task 4: Create a Slicer visual 

In this task, you will create a Slicer using the Date Hierarchy column from the Dates field. 

40. Ensure you have no visual selected and from the Data pane to the right of the screen, navigate to 

and select the Dates table. Select the arrow to the left of the table title to expand the table.  

41. Select the arrow to the left of the Date column, in the Dates table, to reveal the Date Hierarchy 

column. 
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42. Select the Date Hierarchy column from the Dates table and drag the measure to an empty 

design space on the report page. 

Note:  Hierarchy columns are displayed with a grouping image icon – indicating that there are 

navigation levels for the column. For example, Date contains the levels Year, Quarter, Month, and Day. 

 

 

 

43. With the default Table visual selected, select the Slicer visual icon from the Visualizations pane.   

Note:  The default visual that is created is dependent on the data type of the field. In this example, the 

default visual created was a Table. We simply changed the visual from the Table to a Slicer. 
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44. Within the visual, select the down arrow to the left of Year values to expand to the Quarter values 

and explore the functionality within the Slicer visual. 

Note: The Slicer has this behavior because the Dates[Date Hierarchy] column has been created as a 

Hierarchy field in the data model – we can navigate from Year to Quarter, Month, and day.   

 

 

45. Select the Slicer visual within the design report space and drag the visual all the way over to the 

left side of the report page.  Then, expand all the year values to display the year and quarter 

levels. 

46. Then, using the border of the slicer visual, drag to resize the visual until all year and quarter 

levels are shown.  
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Task 5: Resize the Slicer visual 

In this task, you will resize the Slicer header and Items on the Slicer visual. 

47. Select the Slicer visual within the report design space to ensure it is active.   

48. Select the Format visual/Paint Brush icon within the Visualizations pane.  

49. Within the search bar, type the word size to filter the properties quickly.  

50. Within the Slicer header section, change the Text and Values font size to 12. 
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Task 6: Create a Matrix visual 

In this task, you will create a Matrix visual with columns from the Offices table and the measures: 

Potential MRR from the Quotes table, MRR Won – Contracts from the Contracts table, and Won vs 

Potential MRR from the Quotes table.  

51. From the Data pane to the right of the screen, select and expand the Quotes table, and then 

select the Potential MRR measure. 

52. Drag the Potential MRR measure into an empty space within the report design space. 

Note:  By default, you will get the Clustered column chart. 

 

 

53. Select the Clustered column chart visual, within the report design space, to make it active.  

54. Then, select the Matrix visual icon from the Visualizations pane to change the visual to the 

Matrix visual.  
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Task 7: Resize the Matrix visual 

In this task, you will resize the Matrix visual. 

55. Select and drag the visual border to resize the Matrix visual. (You can also select and move the 

visual so that it can be placed closer to the Slicer visual within the report design space.) 

 

Task 8: Add more measures and columns to the Matrix visual 

In this task, you will add two more measures and two columns to the Matrix visual. 

56. Select the Matrix visual to make it active.   

57. From the Data pane to the right of the screen, select the checkbox to the left of the MRR Won – 

Contracts measure, within the Contracts table. This will add the measure to the Matrix visual. 
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Note: Since the field is a measure, Power BI knows to add the field into the Values section of the 

Visualizations pane. 

 

 

58. From the Data pane to the right of the screen, select the checkbox next to the Won vs Potential 

MRR measure under the Quotes table – this will add the measure to the Matrix visual. 
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59. Now, we will add the Region and District columns from the Offices table into the Rows section 

of the Matrix Fields.  

60. From the Data pane to the right of the screen, expand the Offices table.  

61. Drag and drop the Region and District columns to the Rows section under the Build visual tab 

of the Visualizations pane. (Note: District should be placed below Region in the Rows section of the 

Visualizations pane.) 

  

 

 

Note: Each visual has different options listed in the Fields. For example, the Matrix visual contains Field 

sections for Row, Columns, and Values. 

 

 

     Note: The Matrix visual in Power BI Desktop is most like the PivotTable in Excel. 
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Task 9: Resize the Matrix visual 

In this task, you will resize the Text size of the Matrix visual. 

62. With the Matrix visual still selected in the report design space, select the Format visual/Paint 

Brush icon within the Visualizations pane.  

63. Then, type size in the search box and, within the Values sections, change the Values font size to 

12. 

 

Task 10: Use Matrix buttons 

In this task, you will use the Matrix buttons to display the values for District within Region. 

64. Use your mouse to hover over the Matrix visual to display the Matrix navigation buttons.  

65. Select the Expand all down one level in the hierarchy button. 
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66. Resize and move the Matrix visual so that it displays all the information and is located near the 

bottom center of the design report space.  

 

Task 11: Import a Custom Visual – From AppSource 

In this task, you will import the Bullet Chart Custom visual. 

67. Within the Visualizations pane, select the ellipses (…) at the bottom of the visual icon menu. 

68. From the options menu that appears, select the Get more visuals option.  

 



 

Power BI Modern Excel Analyst in a day: Lab 02B 202303 © 2023 Microsoft. All rights reserved. 26 

Note:  If you are already signed into Power BI, you do not need to sign in again.  The next steps are 

only needed if you are not signed in to Power BI. 

 

Note:  If you do not have a Power BI sign in, you can use the Import visual from a file option on the 

Ellipse menu.  Then navigate to the Lab 02B folder and select the 

“BulletChart.BulletChart1443347686880.2.0.1.0.pbviz” file. 

69. Sign into Power BI by entering your username (work email address). 

  

70. If you are already logged in elsewhere within your Microsoft tenant on your computer, you may 

simply be asked to select your identity from a Pick an account list. Otherwise, you will be asked to 

enter your Power BI password. 
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71. From the App store, type bullet in the search bar located in the top-right corner. 

72. Find the Bullet Chart from Microsoft Corporation in the list below and select it to bring up the 

visual’s page inside AppSource.  

  

73. Then, on the Bullet Chart’s page, select the blue Add button to bring the visual into your Power 

BI Desktop report. 
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74. Select the OK button within the Import successful dialog message.   

75. You will now see the Bullet Chart as a new visual icon in the Visualizations pane. 

 

Note:  If you do not have a Power BI sign in, you can use any browser and navigate to AppSource.com 

and download a Custom visual to use with the Import visual from a file option on the Visualizations 

pane.   

Task 12: Use the Bullet Chart Custom Visual 

In this task, you will add the Bullet Chart Custom visual to the report page and add columns and 

measures from the Field pane to the visual. 

76. Use the mouse to select an empty white space within the report design page. 

77. Select the Bullet Chart Custom visual from the Visualizations pane. This will bring you to get a 

new visual workspace. 

78. Select and drag the new Bullet Chart Custom visual above the Matrix visual and resize to fit. 
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79. With the Bullet Chart visual still selected within the design report space, select the Dates table 

from the Data pane. Expand the fields to select the YYYY-QQ column from the Dates table. Then, 

drag and drop the column into the Category section within the Visualizations pane. 

80. Select the Contracts table from the Data pane. Expand the fields to select the MRR Won – 

Contracts measure. Then, drag and drop the column into the Value section under the 

Visualizations pane. 

81. Select the Quotes table from the Data pane. Expand the field to select the Potential MRR 

measure from the Quotes table. Then, drag and drop the measure into the Target Value section 

under Build Visual within the Visualizations pane.  

 

 

 Note:  You can also use the Data pane search bar to enter the name of a column or measure to 

 quickly limit the Data pane to find a column or measure. 
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Task 13: Format the Bullet Chart Custom Visual 

In this task, you will update the Format of your visual/Paint Brush properties within the Bullet Chart 

Custom visual to change the way the visual displays. 

82. With the Bullet Chart visual selected, select the Format visual/Paint Brush icon in the 

Visualizations pane and select the Visual menu.  

83. Expand the Data values properties. 

 

84. Change the Satisfactory % to 60. 

85. Change the Good % to 65. 
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86. Expand the Axis properties and turn the toggle to off. 

 

87. Select the General menu within the Visualizations pane and expand the Title properties. Change 

the Text color to Black.  This will make the Title more noticeable. 
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88. Within the Slicer visual in the design report space, select the year value 2017. You will then see 

the Bullet Chart custom visual change and come to life. 

  

 

Note:  The Bullet Chart is a great Custom visual to show progress towards goals. 

Task 14: Change the Bullet Chart Custom Visual Sort 

In this task, you will change the Bullet Chart Custom visual to sort ascending by YYYY-QQ. 

89. Ensure that the Bullet Chart is selected in the design report space. Then, select the ellipses (…) at 

the top of the Bullet Chart Custom visual. 
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90. Select Sort axis >, then choose the YYYY-QQ column value. 

 

91. Select the ellipses (…) on the Bullet Chart Custom visual again. 

92. Now, select Sort axis>, then the Sort ascending option. 

 

 

 Note:  When changing the sort on a visual using the Ellipse menu, you first need to choose the 

 column or measure to sort by.  Then, you need to select whether to Sort descending or Sort 

 ascending. The final sort by selections are indicated by the yellow vertical bar. 
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Task 15: Use the Bar Chart Visual 

In this task, you will add the Bar Chart visual to the report page, add rows and measures from the Field 

pane to the visual, and use the small multiples feature to create charts split by a field. 

93. Use the mouse to select an empty white space in the report design space. 

94. Select the Clustered bar chart visual from the Visualizations pane to open a new visual 

workspace. 

 

95. Select the Card visual, and then select the Format tab within the ribbon at the top of the screen.  

96. Select the Bring Forward drop-down menu, and choose Bring to Front. 
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97. Select and resize the Card visual, using the border tabs, to make the visual smaller. 

98. Then, with the Card visual selected, drag the visual to the left of the screen, where the right edge 

of the card is aligned with the right edge of the Matrix visual.  (Use the red, dotted alignment lines 

to help guide you; The Card visual will look as if it is hovering over the Matrix visual) 

 

99. Select and drag the Clustered Bar Chart visual to align the top of the visual with the top of the 

Card visual. 
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100. Select the Customers table from the Data pane and expand the fields. Select the Company 

Size column from the Customers table, then drag and drop it into the Y-axis section of the 

Visualizations pane. 

101. Select the Contracts table from the Data pane and expand the fields. Select the MRR Won – 

Contracts measure from the Contracts table, then drag and drop it into the X-axis section of the 

Visualizations pane. 

102. Select the Offices table from the Data pane and expand the fields. Select the Region column 

from the Offices table, then drag and drop it into the Small multiples section of the 

Visualizations pane. 
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Task 16: Format the Bar Chart Visual 

In this task, you will update the Format visual/Paint Brush properties on the Clustered bar chart visual 

to change the way the visual displays. 

103. Ensure that the Clustered bar chart visual is selected within the design report space. If not, go 

ahead and select the visual.  

104. Select the Format visual/Paint Brush icon located at the top of the Visualizations pane. 

Then, select the Visual menu and expand the Small multiples properties.  

105. Next, expand the Layout property. 

106. Change Rows to 5. 

107. Change Columns to 1. 
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108. Switch to the General menu. Then, select the Title properties and change the font color to 

Black.  This will make the Title more noticeable. 

 

 

109. While still viewing the Title section of the General menu, change the Text to MMR by 

Company Size and Region. 

110. Change the Font size to 12. 
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Exercise 5:  Add Conditional Formatting 
to Matrix Visual (Icon) 
In this exercise, you will apply conditional formatted to a Matrix visual. 

Task 1: Apply Conditional Formatting to the Matrix visual 

In this task, you will apply conditional formatting to the Matrix visual. 

111. Select the Matrix visual within the design report space to make it active. 

112. Select the Build visual icon from the Visualizations pane. 

113. In the Values section, select the drop-down on the Won vs Potential MRR measure. 

 

114. From the menu, select Conditional Formatting > Icons. 
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115. Within the Icons - Won vs Potential MRR dialog window, change the Icon layout to Right of 

data. 

116. Then, change the Icon Style to solid shapes, if not already selected. 

 

117. Enter the Rules:  Is greater than or equal to 0 Number and is less than 0.7 Number. 

118. Enter the Rules:  Is greater than or equal to 0.7 Number and is less than 0.8 Number. 

119. Enter the Rules:  Is greater than or equal to 0.8 Number and is less than 1 Number. 

120. Select OK 
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121. Find or create an open area to move the card visual from earlier. 

Your report should look similar to the one pictured below in the figure: 

 

Task 2: Save the File  

In this task, you will save the Power BI Desktop file. 

122. From the ribbon at the top of the screen, select File. 

123. From the list of options to the left of the screen, 

 Select Save if you have saved this file previously with the correct lab name OR 

Select Save as if you are saving this file for the first time and then… 

124. Navigate to the folder <CourseFolder>\MAIAD Attendee\Lab Materials\Lab 02B\ and then 

save the file as MAIAD Lab 02B – My Solution.xlsx. 
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Summary 
In this lab, you started with an existing Power BI Desktop file that contained a partially completed data 

model, background, and theme.  You completed the data model by creating MANY to ONE 

relationships from the Quotes Data table to the Customers, Dates, and Offices Lookup tables.  Then, 

you created measures on the Quotes table so that you could create a report page with Card, Slicer, 

Matrix, and a Bullet Chart Custom Visuals.  You applied Conditional Formatting to the Matrix visual 

using Icons and Rules to show within progress towards revenue goal of each District with Office 

Regions. 
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Reference Mapping learning to Power BI 

Concept  Power BI Desktop Power Pivot in Excel 

File Extension PBIX XLSX 

Edit Queries in Power Query Home > Transform data Queries & Connection > Data > 

Right-click > Edit 

Power Query Transformations Same Same 

Close Power Query Editor Home > Apply & Close                   Home > Close & Load To > 

Connection Only, Load To Data 

Model 

View Data Model table data Data navigation Power Pivot > Manage > Data 

View 

View Data Model table diagram Model navigation Power Pivot > Manage > Diagram 

View 

Create Measures New measure…                                 

 

Power Pivot > Measures > New 

Measure… 

Create PivotTable Visualizations pane > Matrix  Insert > PivotTable > Use this 

workbook’s Data Model 

Apply Conditional Formatting Right-click > Conditional 

Formatting 

Home > Conditional Formatting 

Create Custom Visuals Visualizations pane > Ellipse menu 

> Get more visuals 

Not available in Excel 
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Terms of Use 
© 2023 Microsoft. All rights reserved. 

By using this hands-on lab, you agree to the following terms: 

The technology/functionality described in this hands-on lab is provided by Microsoft Corporation in a 

“sandbox” testing environment for purposes of obtaining your feedback and to provide you with a 

learning experience. You may only use the hands-on lab to evaluate such technology features and 

functionality and provide feedback to Microsoft. You may not use it for any other purpose. Without 

written permission, you may not modify, copy, distribute, transmit, display, perform, reproduce, 

publish, license, create derivative works from, transfer, or sell this hands-on lab or any portion thereof. 

COPYING OR REPRODUCTION OF THE HANDS-ON LAB (OR ANY PORTION OF IT) TO ANY OTHER 

SERVER OR LOCATION FOR FURTHER REPRODUCTION OR REDISTRIBUTION WITHOUT WRITTEN 

PERMISSION IS EXPRESSLY PROHIBITED. 

THIS HANDS-ON LAB PROVIDES CERTAIN SOFTWARE TECHNOLOGY/PRODUCT FEATURES AND 

FUNCTIONALITY, INCLUDING POTENTIAL NEW FEATURES AND CONCEPTS, IN A SIMULATED 

ENVIRONMENT WITHOUT COMPLEX SET-UP OR INSTALLATION FOR THE PURPOSE DESCRIBED 

ABOVE. THE TECHNOLOGY/CONCEPTS REPRESENTED IN THIS HANDS-ON LAB MAY NOT REPRESENT 

FULL FEATURE FUNCTIONALITY AND MAY NOT WORK THE WAY A FINAL VERSION MAY WORK. WE 

ALSO MAY NOT RELEASE A FINAL VERSION OF SUCH FEATURES OR CONCEPTS. YOUR EXPERIENCE 

WITH USING SUCH FEATURES AND FUNCITONALITY IN A PHYSICAL ENVIRONMENT MAY ALSO BE 

DIFFERENT. 

FEEDBACK If you give feedback about the technology features, functionality and/or concepts 

described in this hands-on lab to Microsoft, you give to Microsoft, without charge, the right to use, 

share and commercialize your feedback in any way and for any purpose. You also give to third parties, 

without charge, any patent rights needed for their products, technologies and services to use or 

interface with any specific parts of a Microsoft software or service that includes the feedback. You will 

not give feedback that is subject to a license that requires Microsoft to license its software or 

documentation to third parties because we include your feedback in them. These rights survive this 

agreement. 

MICROSOFT CORPORATION HEREBY DISCLAIMS ALL WARRANTIES AND CONDITIONS WITH REGARD 

TO THE HANDS-ON LAB, INCLUDING ALL WARRANTIES AND CONDITIONS OF MERCHANTABILITY, 

WHETHER EXPRESS, IMPLIED OR STATUTORY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND 

NON-INFRINGEMENT. MICROSOFT DOES NOT MAKE ANY ASSURANCES OR REPRESENTATIONS WITH 

REGARD TO THE ACCURACY OF THE RESULTS, OUTPUT THAT DERIVES FROM USE OF THE VIRTUAL 

LAB, OR SUITABILITY OF THE INFORMATION CONTAINED IN THE VIRTUAL LAB FOR ANY PURPOSE. 

DISCLAIMER This lab contains only a portion of new features and enhancements in Microsoft Power 

BI. Some of the features might change in future releases of the product. 


